
Photoshop offers an abundance 
of color picking tools—there’s 
Color Picker, Color Palette,

Swatches Palette, Custom Color
Picker . . .  and the list goes on. With-
out a general knowledge of your
options, it’s awfully hard to know
where to turn when the color-picking
moment arrives. In this two-part
“Instant Expert,” we’ll take a trip
through the color picking maze and
find out why Photoshop gives you
so many choices. In Part I, we’ll get
acquainted with all those strangely
named color systems (CMYK, RGB,
HSB, etc.), and then cozy up to the
Color Picker Dialog box and find
out why it’s so important to use it
properly.

In Part II, in an upcoming issue,
we’ll discuss the Color Picker
palette, the Eyedropper tool, the
Swatches palette, the Info palette (a
plain looking interface, but more
useful than you’d think!), and
finally, making the most of the
Photoshop measurement tools.

Different Color Systems
Every image you open is in a

specific color mode (RGB, CMYK,
etc.), but that doesn’t mean you
have to use the same color system
to work with your images. Photoshop
can translate any image from one
color mode to the other, so that you
can work within one color system,
and then convert it to another when
you’re ready to process the final
image file (HSB to RGB, for example).

There are many ways to build
colors. Because your image might
be in RGB or CMYK mode, Photo-
shop offers these choices. They
aren’t always the most user friendly
choices, but many people are accus-
tomed to using the three primary
colors—red, green, and blue—
because they correspond to the colors
of light used to display images on a
computer monitor. Photoshop can
handle up to 256 shades of each, so
the numbering system it uses runs
from 0 to 255, where 0 means no
light and 255 means the maximum
amount of light you can display on
your monitor.

Others are more comfortable
defining colors in terms of cyan,
magenta, yellow, and black inks,
the process colors, which are
designated as CMYK (“K" stands
for “key” or black). Each color can
range from 0% to 100%; even
though Photoshop can deal with 
as many as 256 shades of each of
those inks, those who work in the
printing industry find it easier to
describe them as percentages. 

CMY is the opposite of RGB.
Cyan ink absorbs red light, magenta
ink absorbs green light, and yellow
ink absorbs blue light. To confuse
the issue, cyan ink does not absorb
red light alone. The impurities in the
ink cause it to also absorb some blue
and green light. Because of this, 
you cannot reproduce all the colors
you see on your RGB monitor,
especially the bright, saturated

ones. Fortunately, Photoshop has a
warning system built in so you
can’t accidentally choose a color
that can’t be reproduced with
CMYK ink, but more on that when
we discuss the Color Picker.  

HSB Color Mode
Not everyone is comfortable

thinking in RGB or CMYK color.
The HSB model is very helpful for
general color work because it is
based on how most people think
about color. The "H" in HSB stands
for hue, which describes the basic
color you are using (red, yellow,
orange, blue, green, etc.). Hue is
measured in degrees of angle, from
0 to 359 (a total of 360). This can 
be best explained using a visual
approach. If you’re on a Mac, you
can follow along; if you’re using
Windows, just keep reading—you’ll
see why in a few minutes.

Choose File>Preferences>General
and change the Color Picker pop-up
menu from Photoshop to Apple 
and click OK. Now click on your fore-
ground color and see what shows up.
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Part 1: Photoshop’s Color Modes

Change the Color Picker setting to
Apple in order to see the Hues

organized by angle.



Do you see how the basic colors
(also known as hues) are arranged
in a circle? If all you see is a black
circle, then move the slider below
the circle to the middle. Now do you
get a sense of why hue is measured
in degrees? Adobe simply straight-
ened out the circle into a vertical
bar. Look at the normal color picker
again and notice that red is at both
the bottom and top of the vertical
bar. It could just as easily have been
wrapped around a seamless circle
like the one in the Apple Color Picker. 

Before we leave the Apple Color
Picker, let me show you a cool little
trick. Go back to the Apple Picker
and move your cursor outside the
Picker and onto something that is
not part of Photoshop (like your
desktop pattern), then option-click.
That should pick the color you clicked
on even though it wasn’t in Photo-
shop. I wish I could do that with
the normal Photoshop Color Picker!

There is a special Windows Color

Picker, but unlike the Apple’s,
there is no real advantage in using
this version over the normal
Photoshop Picker. 

Back to picking colors using HSB:
Hue alone is not enough to describe
a color. You must also know how
vibrant the color is—is it fire engine
red, or is it more a shade of pink?
This quality of the color is con-
trolled by the Saturation setting.
Colors with low saturation will look
rather gray, with just a hint of color,
and colors with high saturation will
be vibrant and intense. 

There is one more ingredient
you need to flesh out a color:
Brightness. Let’s look at some
examples from real life: When you
tell someone you bought a green
dress, will that person know the
exact color of the dress? No. The
only information you have supplied
is the hue. Is the dress fluorescent
green, or is it dark green? 

Let’s say you ask Kinko’s to
copy a brochure “on one of those
fluorescent papers.” Do you want
fluorescent green or florescent
blue? How likely is it that you’ll
end up with what you want, when
you’ve described only the
saturation you want? Or how
about when you say “I like dark
colors.” Do you mind dark yellow,
or would you prefer blue? 

Occasionally you want to darken
a color in your image. In HSB, all
you have to do is lower the Bright-

ness setting and let Photoshop
figure out how to make the change
using RGB or CMYK values. If you
want five different colors to have
the same brightness and saturation,
you would move only the Hue
setting. You might think a particular
object in your image should be
gray, but you see a color cast in it.
Simply note the saturation number.
If it’s 0, then you really are looking
at gray, but if it’s much higher than
that, then indeed there is a color
cast. You can see what the color cast
is by looking at Hue. 

Lab Color Mode
The Lab color mode is based on

human vision. It can describe all
the colors you can see, far more
than your monitor (RGB) can
display or your printer (CMYK)
can reproduce. Different computer
monitors will display the same
RGB values differently; similarly,
different printers use slightly
different colors of ink. Imagine
trying to reproduce the exact same
shade of red with a crayon, a
magic marker, and a colored
pencil. Since Lab mode is based 
on human vision, there is only one
set of values for each color; in
theory, those Lab values (the
numbers you assign them) will
give you the same color on any
output device, as long as the
device is capable of printing it.

This might seem like an
understandable way to describe
color, but it’s not. The “L” in Lab
stands for Lightness—that’s the
easy part. It’s similar to brightness
in HSB. But then the concept gets
murky. The “a” component is for
colors that range from greenish to
reddish, and the “b” component is
for colors that fall between light
blue and yellowish orange. And if
that isn’t confusing enough, the
numbering system is truly odd: The
lightness is numbered 0-100 and the
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Using Apple Color Picker, you 
can see why the Hues range from 

0 to 359 degrees.

The Photoshop Color Picker places
the hues you found in the Apple

Picker into a vertical bar, yet
measures them as if they were still in

a circular arrangement.

The Windows Color Picker does 
not place the hues around a 

circular shape.



“a” and “b” components are
numbered -50 to +50! 

When would you use the Lab
mode? It’s great for balancing the
brightness levels of two colors.
Here’s an experiment: Choose a
nice red color using any color
system, then move the Hue setting
until you change that nice red to
green. Doesn’t that green color look
brighter than the red you had a
minute ago? If you’re not sure,
squint your eyes. 

Try the experiment again, but
this time when you have the red
color displayed, glance at the Lab
numbers and remember the
Lightness setting. Now swing Hue
to green again. The Lightness
setting changed, because that green
looks brighter than the red you
began with. Now change the
Lightness setting to the setting you
noted when the red was displayed.
The result should be a green that
appears to have the same
brightness as the red (squint your
eyes again if you need to). 

Hexadecimal Color Picker
Now don’t run screaming for the

door. There’s another, slightly bizarre
way to describe color, mainly used
for the Web, called Hexadecimal. It
allows you to specify a range of 0-
255 colors using only two digits!
This computer-friendly numbering
system couldn’t care less whether it
makes sense to our little human
minds, but you will be forced to use
it to create Web pages. Under-
standing the Hexadecimal system
requires some weird math. It’s a
simple concept really, but it takes
getting used to. 

Here’s how it works: We are accus-
tomed to using the numbers 0-9 for
a single digit. In Hexadecimal mode,
you start with zero and can go up
to 9, but then you start using the
letters "a" through “f.” It’s some-
thing like the numbering on a deck

of cards (jack=11, queen=12, king=13).
In Hexadecimal mode, A=10, B=11,
C=12, D=13, E=14, and F=15. But
somehow we need to number the
colors all the way through 255. The
solution is to use two digits, where
the first is multiplied by 16; so “E”
really means 14 x 16=224. The
second digit is simply added to the
product of that multiplication. If
“A” were the first character, then
244+10=254. Kooky! But that’s what
you must use in creating the HTML
code that makes up a Web page.

When you see an area in HTML
code that reads, “BGCOLOR=
A0B6FF,” it means a0 of red, b6 of
green, and ff of blue. If your
Photoshop application is earlier
than Version 5.5, you can either
grab your calculator and start
multiplying, or update to Version
5.5 and let Photoshop do it for you. 

Now that we’ve looked at all the
different ways to build color, let’s
see how Photoshop lets us use all
this stuff.

Color Picker Dialog Box
The most common way to choose

a color is to click on the foreground
color near the bottom of the Tool
palette to bring up the Color Picker
dialog box. With default settings,
you just click on the basic color
(Hue) you are looking for on the
vertical bar and then pick a shade

of that color from the big square
area on the left. You can see the
color you’ve chosen just to the left
of the Cancel button. Right below it,
for comparison, will be the
foreground color you first selected. 

If you are used to using this dialog
box to pick white or black, be very
careful. All too often I find people
clicking in the square area and drag-
ging toward the upper left corner to
choose white. That’s fine, but be sure
to drag all the way past the corner,
otherwise you might be surprised
to find that you have actually
chosen a light shade of gray instead
of white. Do the same thing when
choosing black at the bottom of the
dialog box, but here you don’t have
to be as careful; just drag beyond
the bottom. It doesn’t matter if you
get the corner or not because all the
colors at the bottom are black. 

If you really want black, you can
get it much faster by typing “D” to
reset the foreground and back-
ground colors (or click on the tiny
icon above and to the left of the
foreground color). If you want to
paint with white, then just click on
the curved arrows near the
foreground color, or type “X” to
exchange the foreground and
background colors.

While working in the Color
Picker, you might see two symbols
showing up to the right of your
selected color. If a triangle appears,
then the color you have chosen
cannot be reproduced in CMYK
mode. You can click on it to change
to the closest reproducible color. If a
cube appears (only in Version 5.5),
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Choose colors in Photoshop’s Color
Picker by clicking on the vertical bar
and then choosing a shade of that

color from the square area.

Lower left: reset to default colors icon.
Upper right: exchange

foreground/background colors icon.



it means the color you have chosen
is not a Web-safe color.

Web-safe colors should be used
for all solid areas of color in Web
graphics. If you don’t use Web-safe
colors when you are using a low-
end machine, you could see dithering.
If you are using an older version of
Photoshop, make sure your color is
Web-safe by changing the RGB
settings to 0, 51, 102, 153, 204, or
255. That’s exactly what the color
cube icon does in Photoshop 5.5.

In Version 5.5, you can turn on
the Only Web Colors checkbox to
ensure that only Web-safe colors
appear in the picker.

Default settings are not always
the best ones to use, so let’s see
what else we have available. You
might notice that a radio button is
turned on next to the "H" in the
HSB numbers. That means that the
vertical bar will contain the Hue,
and your other two choices
(Saturation and Brightness) will be
defined by where you click in the
big square area. In the square area,
bright colors are at the top and dark
colors are at the bottom, so bright-
ness runs vertically. Saturated colors
are on the right and unsaturated
colors are on the left, so saturation
runs horizontally. You can change
that—just click on one of the Radio
buttons next to the HSB numbers;
whichever button is turned on will
appear in the vertical bar with the
others appearing in the square.

You can use the same technique
with RGB or Lab colors, but not with
CMYK, because there is room for only
three components to be displayed. 

Picking CMYK Colors
How can you pick CMYK colors

visually using the big square and
the vertical bar? Easy. First, choose
a bright, saturated blue and notice
that the warning triangle shows up.
Click on the triangle and watch
how far the color moves within the
square area. To avoid this
discrepancy, you can choose
View>Preview>CMYK to see only
the colors that are reproducible in

CMYK mode, and you won’t be
surprised with a warning. But you’re
not completely off the hook—you
still have to click on that warning to
get a printable color, so keep your
eye out for it. You could also choose
View>Gamut Warning, and then all
the unprintable colors will be
covered with gray in the Color
Picker, but not in your document. 

If you want someone else to
reproduce the color you have
chosen, you might want to give him
the numbers from the Picker. You
need to pick only one numbering
system (HSB, RGB, CMYK, Lab).
Stay away from the CMYK numbers
if you’re designing for multimedia,
Web, slides, or video; there are many
colors you can display on screen
but cannot print, so do not use
RGB. You can choose a color mode
that suits you, but be forewarned
that most people are not used to
dealing with HSB and Lab.  

If you will be using the color in a
Web page and you own Photoshop
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Top right: non-printable color warning
Bottom right: non-Web-safe color.

The Radio button to the left of the
letters determines what will appear in

the vertical bar.

Hexadecimal numbers appear below
the RGB numbers and can be used

within HTML code. 

By turning on the Gamut Warning,
Photoshop will cover all non-printable

colors with gray.

Web browsers that are low on memory
or being run on low-end computers

display only 256 colors. 
Top: Web-safe colors.

Bottom: non-Web-safe colors dithered

The only Web Colors checkbox limits
Photoshop’s Color Picker to displaying
Web-safe colors (you can still create a

non-safe color using the numbers).



5.5, then use the Hexadecimal
numbers in the lower left. 

Let’s not forget that colors existed
long before the first color monitor
was a gleam in an engineer’s eye.
Take a drive to a graphic arts
supply store and pick up one of the
many different color swatch books.
Pantone is one of the most popular,
but be sure to use the right Pantone
books. If you will be printing the
job on an offset press in process
colors (CMYK), then be sure to use
either the Pantone Process book or
the Pantone ProSim book. You
might want to stay away from the
Pantone Coated and Uncoated
books because they are used when
purchasing ink colors other than
cyan, magenta, yellow, and black.

One of my favorite swatch books
is Trumatch. The colors are all created
from CMYK inks, and because they
have a wide variety and a great 

numbering system (unlike Pantone),
it’s easy to find Trumatch colors
that are similar in brightness, hue,
and other characteristics.

If you work in the newspaper
industry, then you might be familiar
with NAA colors, developed by 
the Newspaper Association of
America. You can visit their Web site
at www.naa.org. The Focoltone Colour
System is not a common swatch book
(http://apmedia.com/pubnet.htm#fcs)

but the colors in it are made from
CMYK inks and they can be useful
to avoid trapping problems. Focol-
tone swatch books show you how
to create the same color on different
papers—so your logo printed in a
brochure on coated paper will be
the same color as one printed on
your uncoated company stationery. 

To access these swatchbook
colors in Photoshop, click on your
foreground color, then click the
Custom button and select from the
Book pop-up menu. The only ones
I’d use are Focoltone, Pantone
ProSim, Pantone Process, or
Trumatch—all based on CMYK
inks. The others should be used in
conjunction with Spot Channels. 

When you are working in this
dialog box, you can type in
numbers to quickly bring up the
color you desire. Unlike most
dialog boxes, there’s not a spot to
click on, so just start typing, and
quickly (otherwise Photoshop
might think you typed in “9” when
you wanted to type “789”). When
you are finished with Custom
Colors, you can click on the Picker
button to switch back to the normal
Color Picker dialog box, or just click
the OK button.

Take a Breather 
I imagine your brain is swelled

up like a wet sponge right now, so
give yourself a break until
“Navigating the Photoshop Color
Mode Options: Part II” appears in
an upcoming issue of PEI. In the
meantime, check out all the free tips
I provide on my Web site, at
www.digitalmastery.com. §

Ben Willmore is the author of the best-
selling book Official Adobe Photoshop
5 Studio Techniques (Adobe Press)
and the founder of Digital Mastery, a
training and consulting group based
in Boulder, Colorado. Find out if Ben is
coming to your area with his “Master
Photoshop In 3 Days” seminar by
visiting www.digitalmastery.com.
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Click the Custom button within the
Normal Color Picker to access

Photoshop’s custom colors.

See Us At PMA—Booth E-46/E-48
More info? PEInfo No. 51
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